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1.1  Proprietary Notice 
The information in this document is proprietary to Güralp Systems Limited and may be copied or distributed for 
educational and academic purposes but may not be used commercially without permission. 

Whilst every effort is made to ensure the accuracy, completeness and usefulness of the information in the 
document, neither Güralp Systems Limited nor any employee assumes responsibility or is liable for any 
incidental or consequential damages resulting from the use of this document. 

1.2  Cautions and Notes 

Cautions and notes are displayed and defined as follows: 

 

 

1.3  Conventions 

Throughout this manual, examples are given of command-line interactions.  In these 
examples, a fixed-width typeface will be used: 

Example of the fixed-width typeface used. 

Commands that you are required to type will be shown in bold: 

Example of the fixed-width, bold typeface. 

Where data that you type may vary depending on your individual configuration, such 
as parameters to commands, these data are additionally shown in italics: 

Example of the fixed-width, bold, italic typeface. 

Putting these together into a single example: 

System prompt: user input with variable parameters 

Specific references to menu buttons or selections are depicted: 

Menu Button 

 

 

 

 

Caution:  A yellow triangle indicates a chance of damage to or failure of the 
equipment if the caution is not heeded. 

Note:  A blue circle indicates a procedural or advisory note. 
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2  System Overview 

Discovery is a graphical application that offers a common interface to a number of 
tools that are relevant to three areas of Seismic instrumentation: 

1. Instrument connectivity, Network Address Discovery and State of Health 
Display 

2. QA of a seismic instrument through data analysis 
3. Management of data storage and archiving - The Güralp Data Centre (GDC) 

Discovery is NOT an essential for managing Güralp Seismic instrumentation. 
However, it is designed with this in mind and offers a set of tools to make that process 
simple. 

Much of the function of the application relates to Ethernet connectivity - either 
locally (LAN) or remotely via the internet (WAN). The system also supports the 
loading and analysis offline data files in the industry standard miniSEED format. 

The applications name “Discovery” refers to its goal of ‘discovering’ an instruments IP 
address. This is done in a number of ways depending on the connectivity. 

A wide range of ‘applets’ are built into the application to assist in verifying an 
instrument’s performance as well as an installation’s quality. This in turn offers the 
ability to diagnose potential problems. 

The third area covered relates to recording and storing data from telemetered 
(Network connected) systems. This GDC function come with a set of tools to assist in 
the installation, managing and support of both small and large (100’s of devices) 
networked arrays of sensors. 

2.1  Key features 

• IP Address discovery on LAN 

• Interface to Güralp Cloud Registry for IP Address and SOH Discovery on WAN 

• Software update tools for Güralp sensors and Digitiser  

• Analytic tools for sensor seismic data such as PSD, Coherence, Self-Noise, 
Correlation Functions, Filter tools 

• MiniSEED Import 

• Sensor Response plotting 

• SOH display, email and text message on event and SOH transitions 

• Graphical front end for GDC configuration and monitoring 

• Sensor orientation and rotation calculation 

• Sensor response and calibration verification 
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2.2  Typical applications 

• Sensor performance verification 

• Sensor/Digitiser management 

• IP Address discovery 

• GDC management 

• Software update tools 

• Digitiser System configuration  
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3  Network Connectivity 

3.1  Operation on a LAN 

In Scan Locally mode, Discovery will automatically find and list Güralp devices 
connected via the local network(s). Discovered devices are displayed in the Discovery 
Main Window, serving as the entry point for the majority of the functionality 
provided by Discovery. Below is an example of Discovery finding devices on the local 
ethernet and WiFi, including a statically set device outside the appropriate netmasks. 

 

Figure 1 Discovery's splash screen, showing various devices 

In addition, basic state of health information is presented in this screen, giving a 
convenient overview of the health of entire seismic networks in a single window. 

A list of network interfaces detected and used by Discovery is shown in the Settings 
page under Device Discovery’s Local Network section: 

 

Figure 2 Discover methods (broadcast or direct broadcast) listed for each interface 
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3.1.1 To DHCP or not to DHCP 

Güralp digitisers default to using DHCP. When coupled with Discovery this works 
seamlessly in locating device IPs. This is more often than not the best solution.  

Static IP addresses often have hidden side effects and require both the netmask and 
default gateway to be set correctly. 

3.1.2 Discovering Devices 

Discovery makes use of broadcast packets to give the best chance of making contact 
with as many instruments as possible. A broadcast UDP packet is sent roughly every 
10 seconds addressed to port 11788. Any Güralp device that receives this packet will 
respond with a single packet.  This response is a Unicast packet if the device sees the 
Discovery packet as emanating from the same subnet. If the device sees the Discovery 
packet comes from another subnet, the response will be a broadcast. 

This minimises the  amount of local broadcast activity but still allows instruments to 
be “discovered” even if their IP address is on a different subnet. This would be the 
case if an instruments address was simply set wrongly on that connection. 

This ability allows an instrument to be “discovered” and then configured even if its 
address is set arbitrarily. 

From when Discovery is put into Scan Locally mode, regular attempts are made to 
probe the local network. This is both to find new devices and to refresh data for 
known devices with the latest state of health information.  

In addition, Güralp devices will emit unsolicited network probes to promote detection 
with instances of Discovery running on their local network as quickly as possible. 
This typically occurs when a system starts up. 

Not seeing an instrument respond when plugged directly into the LAN of a laptop can 
only be caused by firewall rules in the PC. 

3.1.3 Changing IP addresses 

Right-clicking the listed device and selecting Edit Network Address offers the option to 
set the IP Address. This is possible provided the system is on the same physical 
subnet as the computer running Discovery. A broadcast is used to send the new 
address so this will function even if the current address does not the computer’s 
subnet. 
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Figure 3 Change Network Address applet 

3.1.4 Manually Adding Devices 

In most cases it is not necessary to have prior knowledge of the network address of a 
device. However, different operating systems, subnet configurations, network 
topologies and networking hardware can affect the discovery of devices; in some 
cases not every device can be automatically found. In these situations it is possible to 
manually add a known device IP address to populate an entry in the Discovery main 
window. 

Select the Edit menu option, followed by Add Device. 

Manually adding a device’s IP address can also be useful where direct 
communication is possible but outside of the local network, beyond the reach of 
broadcast packets; for example where a VPN has been used to connect to a remote 
device. 

This is not a common use case. 

3.2  Operation over a WAN 

Where instruments are not located on the same local network as the instance of 
Discovery, the same automatic device detection as outlined for local devices is not 
possible. Moreover, network features such as firewalls and Network Address 
Translation often prevents direct communication between remotely located Güralp 
devices and Discovery instances completely, even if the device’s IP address is already 
known. 
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3.2.1 Registry Server 

Even in situations where direct network connectivity between Discovery and Güralp 
instruments is not feasible, device discovery and live instrument state of health 
updates are still possible. As long as both the Discovery instance and Güralp device 
are able to make outgoing connections to the same WAN (for example, the internet), a 
Güralp Registry Server may be used to facilitate communication between them. 

A Registry Server is a publicly accessible server located on the WAN which is 
running Güralp’s Responder software as a service. 

A single outbound UDP packet is sent from the digitiser to the Registry Server every 
10 seconds by default. The destination port number is 11788.  

At deployment, instruments can be configured to make themselves known to one or 
more Registry Servers. In this fashion, a constantly updated list of instruments, with 
their state of health information, is maintained for a distributed network of seismic 
stations and devices. 

Choosing Registry mode in the Discovery main window causes Discovery to poll the 
configured Registry Servers for their listed devices. The Main Window will be 
populated with these devices, displaying their identifying information, network 
addresses and state of health as if they had been discovered locally. 

It comprises a simple binary that runs headless on a computer. A single UDP port 
11788 must be open. 

WAN Address reflects packet return address in packets received by registry from 
devices. 

LAN Address reflects the instruments address on its ethernet interface. 

3.2.1.1 Güralp Public Registry 

To allow users to try this functionality before setting up their own Registry Server, 
Güralp hosts public Registry Servers for customer use. Only systems that have a 
matching “Group ID” are visible to a particular user. This service offers a simple way 
to discover the IP address of a system and to see the basic State of Health parameters 
of the system.  

The default registry address shown below is programmed into all Güralp digitisers 
systems as a default. 

52.34.40.123   IP address of Güralp’s Default Public Registry 

To set up your own Registry Server, contact Güralp Systems for further information. 
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3.2.1.2 Setting Up Güralp Registry 

As mentioned previously, registered devices must be assigned to groups, each of 
which has a “Group Identifier”. Instances of Discovery must also be configured with a 
Group ID and can only display registered devices from the matching group. This 
allows partitioning of large networks into smaller administrative domains. It also 
makes the simultaneous use of the Güralp shared Registry Server by multiple 
organisations possible. 

Therefore, to use the Registry, you need to configure both the device and Discovery. 
Please follow these steps to set up your Registry. 

• First, the address of the Registry Server and the chosen Group ID must be set 
individually for each participating device. To do this, first connect the device 
to the same network as a PC running Discovery. Then open the webpage and 
set Group ID and Registry address from the Network tab. To use the Güralp 
shared cloud server, enter 52.34.40.123.  

• Once you have set these values, the device must be rebooted before the 
changes will take effect.  

• Last, open Discovery and click on Cloud server configuration at the bottom left 
of the main window. Enter the Group ID and server IP address in the relevant 
fields (“Group identifier” and “End point address”, respectively). Click on Apply.  

From Discovery’s main window, click the Registry button and all devices configured 
with the same Registry server and Group ID will now appear in the main list. 

 

Figure 4 Cloud Server Configuration window 
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3.2.1.3 Setting Up Your Own Registry 

Administrators can create their own registry servers by installing a simple program 
on a server. The server itself must have a static IP address and be accessible to all 
connected devices, as well as the PCs running Discovery. 

In order to create your own registry, Please follow these steps to set up your Registry. 

• Contact Güralp technical support (support@guralp.com) to receive a copy of 
the program; 

• Download the file attached to your email; 

• Run the binary guralp_responder on a Linux machine with a -d switch using 
the command:  

./guralp_responder  -d  

• Open the instrument’s webpage and change the Registry IP address on the 
Network tab to be the one of the PC where the responder is running. Set a 
Group ID using the key you prefer. Repeat for all the instruments you want to 
add to the Registry; 

• Open Discovery and change the IP address from Cloud Server Configuration on 
bottom-left of the window with the one of the PC running the responder; 

• From the same window, set the same Group ID you used in the instrument’s 
webpage; 

• Click on Registry button in Discovery. 

You should now see the configured devices appearing in Discovery main window 
when you click on Registry button. 
 
In order to make it work, the following network ports need to be open: 
  
UDP 11788         
UDP 11789         
TCP 11789 

 

 
If the instruments and the machine running the responder are in different networks 
you have to make sure that the ports in Table 1 below are also open/forwarded.  

Note:  The PC with the responder and the PC with Discovery cannot be the 
same machine because the same port 11788 cannot be used for different 
purposes. 

mailto:support@guralp.com
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3.2.2 Interacting with WAN Instruments 

Beyond the information transmitted via Registry Servers, as outlined above, the 
functionality available for each instrument in Discovery depends upon network 
connectivity between the Discovery instance and the device. 

In terms of configuring firewalls, the product manual provided for each Güralp device 
will outline the required open network ports for given functionality. 

The most common are: 

Table 1 List of the main required open network ports 

Port Layer 4 Protocol Description 

80 TCP HTTP server 

1565 TCP GDI transmission protocol 

1567 TCP/UDP GCF transmission protocol 

4242 TCP File exchange protocol 

4244 TCP Remote console 

11788 UDP Remote procedure calls 

18000 TCP SEEDlink transmission protocol 
 
The most common and significant hurdle to communicating with remote devices is 
Network Address Translation. A number of solutions are here presented. 

Right-clicking on the instrument row (on any column BUT the LAN address one) 
offers various functions that will all use the WAN address to communicate with the 
instrument. So all will function as expected as long as ports are open. 

Right-clicking on the LAN address column forces the use of the LAN IP address to 
communicate with the device instead. 

3.2.2.1 Port Forwarding 

In some cases, depending on networking equipment and topology, it may be possible 
to arrange the relevant device network ports to be forwarded by the WAN router. This 
allows direct connections to the remote device. 

If a device is made available via port forwarding, users should initiate Discovery 
functionalities using the WAN address of the instrument. Where multiple network 
addresses are available for an instrument, it is possible to force Discovery to use the 
WAN address by selecting the WAN Address column of the device entry. Subsequent 
invocations either via the Edit menu or the right-click context menu will then utilise 
the WAN address. The WAN address is used by default when in Registry Mode 

It is common when port forwarding to remap port numbers away from the default 
internal device ports when presented to the WAN. Discovery allows for this by 
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allowing for per device custom port numbers. Right-clicking on the instrument and 
selecting Device Port Configuration opens a window to change forwarding ports for an 
individual instrument. 

 

Figure 5 Port configuration window for an individual device 

3.2.2.2 Router/Gateway VPN 

Some WAN routers include a VPN client feature which may allow remotely located 
instruments to appear as if they are on the same local network as the Discovery 
instance. Setting up a VPN is beyond the scope of this manual. 

In some cases it is necessary to manually add devices which are accessible via a 
VPN, by selecting Edit → Add Device. 

3.2.2.3 Güralp Discovery Tunnel 

The easiest way to overcome firewall and NAT networking challenges with remote 
instruments is to use the Güralp Discovery Tunnel. By combining a Güralp device 
running Dig firmware with a Registry Server and Discovery, it is possible to maintain 
full connectivity with remote WAN connected instruments without any extra 
network configuration (beyond connecting the instrument to the WAN). 

This feature allows all network traffic between a Discovery instance and instrument 
to be routed via a Registry Server, using only outgoing TCP connections from each 
end point (device and Discovery instance). In this way, full communication is possible 
through firewalls and NAT routers without special configurations or degrading 
network security. 
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Figure 6 Discovery Tunnel 

To enable this feature, relevant Güralp devices should be assigned to a Registry server 
and the Tunnel Auto Connect setting should be enabled. Where multiple Registry 
servers can be configured, the first Registry server slot should contain the tunnel 
enabled Registry server. For more details refer to the device manual. 

To allow connectivity via a Registry server, the tunnel option must also be enabled 
when starting the Responder service. For more details refer to the help information 
for Responder. Port 8190 TCP is used to make the connection to the remote registry 
server from the digitiser – so this outbound port must be permitted in any firewall 
rules. 

Generally, all that is required is the enable of the tunnel connection within the 
instrument by ticking the Tunnel Auto Connect box from the webpage, under the 
Network tab. 

 

Figure 7 Discovery tunnel option available from the Network tab of the instrument webpage  

In Registry mode, the Discovery Main Window will display the tunnel availability of 
listed devices. If this column is not displayed, it can be enabled by selecting Window 

→ Show → Tunnel Available. Devices connected to a tunnel enabled Registry server 
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(and with tunnel connection enabled) will be indicated with “Available” in the Tunnel 
Available column. 

 

Figure 8 Tunnel status shown in main device list 

To utilise the tunnel connection, simply invoke a Discovery applet with the chosen 
device selected in Registry mode. Discovery will automatically default to using the 
tunnel network address for all communications with the instrument (unless the user 
specifically selects the WAN or LAN fields). 

More information regarding the tunnel’s operation is shown in the Tunnel Status 
applet available by right-clicking on the entry of a device whose tunnel is enabled. 
This provides detailed status and connection information for each tunnel connected 
device. 
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Figure 9 Tunnel status applet 
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4  Main Device List Window Overview 

4.1  Instrument State of Health Information 

4.1.1 SOH on LAN 

The instruments response to the Broadcast discovery packet on the LAN contains a 
range of state of health (SOH) information. The instrument’s serial number, software 
version, supply voltage, temperature, event trigger status are all included. 

To choose which parameters to display on the main window, click on Window → Show 

and tick the boxes of the desired parameter. 

The displayed values are typically shown with a latency of about 10 seconds. The 
time of last contact is remembered so an instrument that stops working or becomes 
disconnected from the network will be shown with its last (old) contact time. 

Manually clicking the Scan Locally button, or the shortcut key F5, will clear the display 
of old instruments, losing the knowledge of the last contact times. 

 

Figure 10 Example of some of the available parameters showing instrument's state of health 
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4.1.2 SOH via registry on WAN 

Operationally, the available SOH parameters for devices on a WAN are much the same 
as above. The information latency is between 10-20 seconds as the data must be 
fetched from the Registry server rather than directly from the device. The 
information remains on the Registry server for 24 hours (configurable). Restarting the 
local Discovery or pressing the Registry button simple re-fetches this SOH information.  

The registry server can be configured to send emails or text messages when some 
changes happen in the systems in the Registry, such as: 

• a system (which was not in the network) appears into the network 

• a system disappears from the network (lost contact for more than 2 minutes) 

• a system re-appears into the network 

• the Status of a system changes 

• an event is detected. 

This functionality makes the monitoring of medium-large network easy and efficient.  

4.1.3 Options for emailing SOH changes 

HOW TO CONFIGURE FOR EMAILS – Work in progress…. 

4.1.4 Options for SMS message updates 

HOW TO CONFIG FOR TEXT – Work in progress…. 

4.1.5 Additional SOH direct from instruments 

Work in progress…. 

4.2  Connectivity 

The IP addresses listed can be used to make connection with the digitiser devices. 

slinktool -S DG_05656 -v -p min-5656 

slinkttool -Q 192.168.1.2 

telnet 10.20.1.2 -P 11789 

Ping 10.20.1.1 

Example of connection to a seedlink server: 

telnet min-5656 18000 
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Trying 10.30.0.7... 

Connected to min-5656. 

Escape character is '^]'. 

HELLO 

SeedLink v3.0 (MIN-5656 CAP Testing 3) :: SLPROTO:3.0 

DG.05656 

4.3  Main Window Applets 

Right-clicking on a system offers a number of operations that depend on the recognised 
instrument type and potentially software version. Some of the available applets are intro-
duced in the following Sections. 
 

 

Figure 11 Right-click menu 
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4.3.1 Firmware Update 

 

The Firmware Update applet offers automatic download of appropriate versions for 
Minimus, Minimus+, Fortimus and Certimus units. The software is then sent to the 
instrument where it is verified and stored before installation begins. Network 
problems during the upgrade process are therefore NOT an issue. The update is only 
performed at the instrument when all information is on the instrument. The update 
will continue even if the network disconnects at that point. 

System updates do not affect the network settings such as IP address. Other 
parameters are typically reset to defaults when the new software starts up for the first 
time. Older system settings can be automatically re-applied after the update 
completes if the suitable options are ticked in the applet. 

  

Figure 12 Firmware Update applet for firmware update of Minimus, Minimus+, Fortimus and 
Certimus 

Much of the applet is concerned with where the firmware file should be downloaded 
from. Typically,  this will be from the Güralp webserver. There are always 2 versions 
available: the current qualified stable release and an experimental (Beta) build. 

The experimental build is typically based on the last stable build but with additional 
bug fixes and features. It is generally not recommended to use the experimental 
version for active deployments unless directed by Güralp support. 

Caution: Do NOT follow these instructions to update the firmware of 
Minimus2, Minimus Lite and Artius. To update the firmware of Minimus2, 
Minimus Lite and Artius units, follow the procedure in Section 4.3.4.1. 
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Once an update has completed successfully from a local file path, it is then possible to 
perform multiple updates on other systems in one operation.  Simply select a group of 
instruments in the devices list and right-click the Firmware Update option. This will 
launch multiple update applets that will run in parallel. Each will close as it 
completes. 

4.3.2 Live View -GDI/GCF 

The Live View applet launches the live seismic data viewer and a stream of data is 
initiated. The GCF protocol is offered for older systems. Newer systems all support the 
GDI protocol (and SeedLink). GDI (Güralp Data Interchange) runs over a TCP 
connection. It supports the concept of additional metadata on each stream as well as 
multiple streams on the same TCP connection at potentially differing sample rates. 
The protocol generally has a lower latency than GCF or SeedLink as samples are sent 
when ready rather than waiting for a full packet. When several channels are used (Z, 
N, E, Mass etc) this results in efficient packets being sent with a mix of the channels 
depending on sample rates. This differs to SeedLink where a packet contains only 
one channels data and must be filled with that channel alone before transmission. 

The addition of metadata in the connection also ensures that instrument response 
and calibration parameters are inseparable from the seismic data. When a connection 
is made the calibration and response and SI Units etc all come automatically. 

Figure 13 Waveform viewer main window 

The left hand list of channels can be used to enable the display of the data in right 
hand viewer by using the tick boxes.  Hovering over the name in the Channel List or 
the Channel name box in the viewer will display a hover help list of the channel’s 
metadata as shown below: 
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Figure 14 Channel associated metadata 
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4.3.3 Web Page (System Browser) 

 

Figure 15 An instrument's WEB page 

Most Güralp product’s configuration can be viewed and modified via a Web page, 
which can be accessed by selecting the applet View Web Page. This is served by a 
HTTP Server within the instrument or Digitiser. This option launches a WEB viewer 
from within the Discovery software. This has limited functionality but is more than 
sufficient for most operations. The system browser can be launched if an alternative 
browser is required for say download management. 

An instrument’s webpage can also be accessed by typing the instrument’s IP address 
in a web browser. 
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4.3.4 File Exchange 

 

Figure 16 File exchange window 

File exchange enables files to be sent to a digitiser or received from a digitiser. This can 
be used for log files, station XML etc and software updates of certain systems and 
sub-systems. 

When sending a file to a digitiser the ‘Upload as’ field specifies the name of the file as 
written in the digitiser. This is typically of importance as a number of specific 
filenames are known to the receiving systems and are used as the cue to decide what 
to do with the new file. 

Some examples below: 

‘certis.bin’ – software for the Certis instrument 

‘femtomus.bin’ – software for Aquarius and Certimus ultralow power internal 
digitiser 

battery_project.bin – Power Pack Module firmware update 

Once the filename paths are set up in the applet, multiple systems can be updated in 
one hit. Simply select a group of instruments in the device list and right-click the File 

Exchange selection. This will launch multiple applets that run in parallel. The popup 
will close automatically as it completes the transfer.  

 

The file exchange window can also be used to run a script file that contains a list of 
commands to be executed at specific dates and time. This can be used for operations 
such as scheduled instrument calibration. For more details, see Section.  

Note: This does not mean that an update is fully complete – only the 
file transfer.  Watch the LEDs on the instrument or the device list to 
reflect the new version etc. before repowering anything. 

Receive a file from 
Instrument 

Send a file from PC to 
Instrument 
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4.3.4.1 Minimus2, Minimus Lite and Artius Firmware Update 

File Exchange, specifically the bottom section called File Upload, is also used for 
updating the firmware of the Minimus2 and Minimus Lite units. The Prepare 
Firmware Update option automatically downloads the most recent stable or 
experimental build from the web and fills in the columns above, ready for the upload.  

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 11  File Exchange applet for firmware update of Minimus2 and Minimus Lite 

4.3.5 System Configuration 

A Configuration Import/Export tool can be access by selecting System Configuration. 
All Güralp digital sensors and digitisers have the idea of configuration files. These 
allow the entire system configuration to be copied from a system and reapplied to 
another system (or systems). 

The config file is in text readable format. It comprises name/value pairs. The names 
are the same as they appear on the instrument’s web page. Text values appear as they 
do on the web page. Pulldown menus appear as enumerations (index into the list). 

The config files can be manually edited if desired. It is also possible to remove items 
from a config file. This has the effect of those parameters remaining unchanged 
when the settings are applied. This may be useful when a group of instruments with 
unique system and station names require all their channel sample rates changing 
without affecting other parameters such as the names, or you can make a file with 

Caution: When using the Stable and Experimental buttons next to Prepare 
Firmware Update for the update process, it is vital that the name next to 
“Upload as” remains unchanged. Any alterations will result in issues after 
uploading this new firmware. 

 



Güralp Discovery - Software Manual  Main Device List Window Overview 

MAN-DIS-0001 31  

 

perhaps just one parameter that can be sent to a group of systems to change just that 
singular setting.  

 

Figure 17 System configuration window 

To perform mass configuration, preselect a group of instrument in the Discovery 
device list, right-click and select System Configuration. The applet below appears with 
the instruments preselected (ticked). Further selection of additional instruments can 
be performed before uploading a chosen file to all the selected systems in parallel.  
Once the Upload is complete, the Reboot Selected button can be used to restart all the 
instruments in one button press. 

Loading an old .config file onto a system with newer software is perfectly acceptable. 
Any new parameters added in the newer version will simply not be modified by the 
upload. 

Check the systems that will receive the config file when 
the “Upload configuration” button is pressed.  

Note: selecting a group of systems from the systems list 
before right-clicking the configuration option will have 

the same effect 
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Figure 18 System configuration import/export tool 

4.3.6 Running Scripts 

A shell script can be run directly from Discovery. The script receives the instruments 
Hostname and IP Address as the first two parameters. 

Both Linux and Windows builds of Discovery support this operation. With Windows it 
is necessary to install the Linux shell functions of Windows 11 onwards. 

Bash or Python or any shell scripts can be run in this manner. 

Group selection of multiple systems results in multiple shells being launched to run 
each script. An example of this would be to instigate a data download from the 
instrument’s web server. These downloads will all operate in parallel for maximum 
speed. This is an effective way of offloading systems after a deployment. 

In order to run scripts, first configure the folder that contains the script files by 
editing the config2.ini file (see Section 9.1 to find out the location of this file). Add the 
tag ScriptFilePath= to the folder that contains the script files. Files must be named 
“discovery_xxxx” They will appear in the right-click context menu under Scripts: 
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Figure 19 Script files are listed automatically 

The example below fetches all the data files from the digitiser. This is using the HTTP 
(WEB Page) protocol to download all the files shown on the file list page of the 
instrument. Scripts are only supported on the Linux version of Discovery. 

 
#!/bin/bash 
set -x 
foo=$(date +%Y-%m-%d) 
mkdir $foo 
cd $foo 
mkdir $1 
cd $1 
wget -rnp http://$2/tab9.html 
cd .. 
 
 

4.3.7 Calibration 

Calibration is a procedure used to verify or measure the frequency response and 
sensitivity of a sensor. It establishes the relationship between actual ground motion and 
the corresponding output voltage. Calibration values, or response parameters, are the 
results of such procedures. 

Response parameters typically consist of a sensitivity or "gain", measured at some 
specified frequency, and a set of poles and zeros for the transfer function that expresses 
the frequency response of the sensor. A full discussion of poles and zeros is beyond the 
scope of this manual. The gain for a seismometer is traditionally expressed in Volts per 
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ms-1 and, for an accelerometer, in Volts per ms-2. Other instruments may use different 
units: an electronic thermometer might characterise its output in mV per °C. 

A calibration procedure is also used to establish the relationship between the input 
voltage that a digitiser sees and the output, in counts, that it produces. The results are 
traditionally expressed in Volts per count. Güralp digitisers (Minimus, Minimus+, 
Minimus2 and Minimus Lite) are programmed at the factory so that they know their own 
calibration values. However, when an analogue sensor (e.g. Güralp Fortis, 3T, etc.) is 
connected to a digitiser of the Minimus family you are required to manually input the 
sensor’s calibration values. 

To enter the calibration values for your analogue instruments, right-click the digitiser’s 
entry in Discovery’s main window and select Calibration → Edit Poles & Zeros. This actions 
opens the Calibration Editor window. 

This form has one tab for each seismic component, mass position and a calibration 
channel. The instrument's response values should be entered in here. These are: 

•  The Digitiser Volts per Count (VPC) – the ratio between the input voltage and the 
digitised output value (“counts”). This field will be populated automatically with 
the correct value for this input channel of the Minimus.  

• Analogue Instrument Gain – this specifies the output voltage of the analogue 
seismometer per unit of ground motion, as measured at 1 Hertz. This information 
is normally provided on the calibration document that is shipped with the 
instrument. In the calibration document, this parameter is often referred to as 
“Velocity Output V/m/s” or “Acceleration Response V/m/s2” depending on the 
analogue instrument. This value can vary slightly across the three components. 

• The ADC offset is the quiescent output seen when digitiser input is zero. This field 
will be populated automatically with the correct value for this input channel of the 
Minimus. 

• The Coil constant is the coil constant for the component being calibrated, in 
A/ms- 2, as given on the analogue sensor calibration sheet. This value is the same 
across all three components. This value is not relevant when Minimus is used 
with a Güralp Fortis accelerometer or Güralp Certis broad-band seismometer. 

• The Calibration resistor is the value of the calibration resistor, in Ω, as given on the 
sensor calibration sheet. This value is the same across all three components. This 
value is not relevant when Minimus is used with a Güralp Fortis accelerometer or 
Güralp Certis broad-band seismometer. 

• The Normalising factor specifies the value that the transfer function (as specified 
by the poles and zeros) must be multiplied by in order to provide unity gain at 1 Hz. 
This value is the same across all three components.  

• The Poles and Zeros describe the frequency and phase response of the component. 
They must be specified in Hertz. This information is normally provided on a 
calibration document that is shipped with the instrument. If poles and zeros are 
not included in your calibration document, nominal values can be found here: 
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https://www.guralp.com/apps/paz/. This value is the same across all three 
components. 

 

Note:  If the calibration document is lost, please visit the website to learn how to 
request a copy (https://www.guralp.com/customer-support). 

Figure 20 Calibration Editor window 

https://www.guralp.com/apps/paz/
https://www.guralp.com/customer-support
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The calibration parameters for one component can be copied to any other component of 
the same instrument, or other instruments. This is especially useful for poles and zeros 
because they are typically identical for all three components of all instruments in a class.  

Within the “Component configuration” section, the “Copy:” drop-down box  allows the 
selection of what to copy: poles and zeros, parameters, or All(tab dependant). The 
destination sensor can be set in the “to sensor” box and takes the numeric identity of the 
sensor as detected by the Minimus. Finally the specific components can be selected in the 
“to component” drop-down box. Click on the Copy button to copy and paste the selected 
values. Finally click on Send axis Z  button to send the calibration values to the digitiser 
and save them permanently. Repeat this last step for the other axis. Note that Send axis Z 
only sends the calibration of the selected axis. 

 

Figure 21 How to copy parameters to various components. 

The overall system calibration parameters can be exported and saved in a file for future 
use by clicking on the Export to file button under “System calibration values”. 

 

Figure 22 How to apply instrument calibration values. 

The resulting filename will have the extension “.conf". Values from an existing 
calibration file can be imported using the Import from file button. The associated drop-
down menu allows specification of what to import: poles and zeros, gains, or everything. 
Click on Send sensor0 calibration to device to send the calibration values to the digitiser and 
save them permanently. 

 

 

Note: When using Minimus+, this action will only send the calibration of the 
selected sensor. Click on the Send to device button to send the complete 
calibration to the digitiser. 
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5  Tools Menu 

There are a number of tools and applets available which perform functions that are 
not specific to devices. These are available  in the Tools menu 

5.1  MiniSEED to Directory Structure 

Güralp instruments record data in miniSEED format. These files can be offloaded 
from the SD cards. The directory structure on the SD cards is flat and comprises 
128Mbyte files. 

These file are pre-created and stretched to 128Mbytes. The key reason for this is to 
prevent the File Allocation Table (FAT) being constantly updated as the system 
records. In fact, a loss of power during the update of the FAT would result in a loss of 
most or all data on the card. The pre-stretched files are never extended during normal 
operation so a loss of power during a write would result in just one corrupt block in 
the middle of a miniSEED file, which is typically skipped over by any reader. 

This tool allows you to chop a large miniSEED file in smaller miniSEED files with a 
fixed length of 1 hour. It will process the miniSEED files to create a folder structure of 
month/day/hour with the hour-long miniSEED files in each folder. 

 

Figure 23 mSeed to Directory Structure window 
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Figure 24 Resulting file hierarchy 

5.2  CAP Receiver 

Instruments can detect local events using a number of algorithms.  Typically, an 
STA/LTA trigger is used. This is relatively immune to slow changes in background 
noise such as day to night.   

A trigger can be configured to send a message (CAP – Common Alert Protocol). Güralp 
Discovery includes a CAP receiver. It listens on a specified UDP port for incoming CAP 
messages. When one arrives, it can be displayed on a map alongside a table of 
information. Furthermore, there is a user defined event window where Discovery’s 
CAP receiver will receive multiple event messages and evaluate them producing: 

• An event log containing all the raw CAP messages received during the event 

• An Event Report PDF listing crucial details from the event messages 

• An epicentre based on trigger times of the event messages 

• A GeoJSON file for importing the results to third-parties  

On generating the above the CAP Receiver will stop listening for CAP messages and 
open a new instance that will continue listening for new events. This allows the user 
to review the data inside the CAP Receiver if needed whilst still actively listening. 
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5.2.1 Network Settings 

 

Figure 25 CAP receiver network settings 

The CAP receiver window allows specification of the listening port. This is available 
by clicking on Settings and then on the Network tab. Each device from which 
messages should be received must have this value specified as the “CAP Port” in its 
triggering settings (from the Trigger tab of the webpage). The value should be 
between 1025 and 65535. You should avoid numbers in the list at 
https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers. 

Note: In order to receive CAP messages, please make sure that the CAP 
receiver has been started by clicking on the Start button. If you see 
instead a Stop button, it means that the CAP receiver is already 
listening. 

 

https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers
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If you wish to forward the CAP messages to a server, type its I.P. address into the field 
and tick the check-box named “Forwarding server”. An error message is displayed if 
the entered I.P. address is not valid. 

5.2.2 Map & Table View 

 

Figure 26 Discovery's shake map 

Each row of the table contains information from a CAP message, such if you have 
three devices trigger you will see three rows in the table. If the device is setup to send 
Peak Ground data or remote triggers, these will merge with the initial trigger they 
relate to. This means after the initial trigger is received the PGA column may be 
empty but it will populate when the Peak Ground data comes through later on. 

 

The column headers in the table are configurable in Settings, giving a range of useful 
information from the CAP messages. Colour coding schemes are used for the PGA 
column and optionally for the Sender column if Site Fragility is enabled. is used to 
show individual station’s PGA values in the list. The list can be sorted by clicking on 
the column header. 

Note: For full instructions about how to configure triggers using 
instruments that run the DIG firmware (i.e. Minimus, Minimus+, 
Fortimus and Certimus) see DIG firmware’s manual (MAN-DIG-0001). 

Note: PGA, PGV and PGD are available only for instruments running 
the DIG firmware (Minimus, Minimus+, Fortimus and Certimus. NOT 
Minimus2/Minimus Lite). To receive PGA, PGV and PGD information, 
the EEW parameters have to be enabled. See DIG firmware’s manual 
(MAN-DIG-0001) for more details. 
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Clicking on entries in the list will highlight the location on the map – and vice versa. 

Each device that has triggered is displayed on the map as a black cross. Red crosses 
on the map reflect sensors that have some form of compromised performance – 
possible timing inaccuracies or poor connectivity 

5.2.3 Colour Categories – Site Fragility 

There is a default colour category for PGA values which will colour the PGA column 
of the CAP message table in either green, yellow, orange, or red (for most severe). 

An advanced colouring option called Site Fragility can be used to colour the Sender 
Name column and optionally be used to colour the PGA column as well. 

 

Figure 27 – An example of Site Fragility categories overriding PGA categories 

In the above example the event table has been ordered by PGA and we can see the 
colouring is no longer dependant entirely on PGA but is different per site. Each site 
has PGA limits set for it. This can be found in Settings on the Categories tab: 
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Figure 28 – Settings, Categories tab 

The format of the CSV file is <sender-name>, <red>, <orange>, <yellow>, <green>. 
Where the colours relate to a PGA value (it turns red after the PGA reaches <red>). 

5.2.4 Event Report & GeoJSON 

When an event window closes, or when the user presses Generate PDF, a PDF is built 
from the information in the current event’s CAP messages. This displays the sender 
information, timestamps, Peak Ground data, and latitude/longitude. The example 
below uses faked data which is why there are no PGV or PGD values. 
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Figure 29 - Example of an Event Report PDF 

When an event window closes, or when the user presses Export JSON, a JSON file is 
built from the sender name, PGA, and latitude/longitude for all current CAP messages. 

 

5.2.5 Download Data 

Stream data can be download from the selected instruments by selecting them either 
in the table or on the map view and pressing the Download data button. 

The time range to download is configurable in Settings allowing a range before the 
event and a range after. 
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5.2.6 Triggers – Voting  

When multiple instruments are deployed within a network, a voting scheme is 
typically used to reduce false triggers. Local voting among sensors helps filter out 
spurious events, as simultaneous triggers from widely spaced sensors are highly 
improbable in the absence of a genuine seismic event. 

The voting scheme in Discovery’s CAP receiver is characterised by two parameters: 
the voting threshold and the event window. These two parameter can be set from the 
Events tab of the CAP receiver Settings.  

Note: Immediately after an event occurs the device will not have 
copied the data across so requesting data with Download data will not 
be successful until some time afterwards. 
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The voting threshold defines the minimum number of CAP messages that must be 
received within a specified time frame (event window) to confirm an actual event. 
When a new CAP message is received, the event window is initiated. If another CAP 
message arrives within the event window, the timer resets, and the full duration of 
the window begins again from that point. If the threshold is not met before the event 
window expires (i.e., no new messages extend it further), Discovery’s CAP receiver 
terminates the instance, discards all collected messages and takes no further action.  

 

The total number of CAP messages sent by an individual instrument varies 
depending on its settings. 

When a trigger is configured on individual channels, a CAP message is immediately 
issued upon trigger activation. If the EEW (Earthquake Early Warning) transform is 
applied to that channel, a second CAP message is sent a few seconds later containing 
the calculated PGA (Peak Ground Acceleration), PGV (Peak Ground Velocity) and PGD 
(Peak Ground Displacement) values.  

Triggers can also be configured on seismic triplets. In this case, triggering can be 
based on the 3D resultant of the Z, N and E components together, or the Z component 
and the 2D resultant of the N and E components separately. In this case, a CAP 
message is issued upon trigger activation, and additional CAP messages are sent if 
the EEW transform is enabled. 
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The table below provides some examples of trigger configurations and the 
corresponding number of CAP messages generated. 

Source EEW transform Triplet options Triggered 
channels 

N° CAP 
messages 

Single tap Disabled   1 

Single tap  Enabled   2 

3 × Single tap Disabled   3 

3 × Single tap Enabled   6 

Triplet Disabled 3D  1 

Triplet Enabled 3D  2 

Triplet Disabled Z & NE Z or NE 1 

Triplet Disabled Z & NE Z and NE 2 

Triplet Enabled Z & NE Z or NE 4 

Triplet Enabled  Z & NE Z and NE 5 

 

 Note: EEW transform is only available for Minimus, Minimus Plus, 
Certimus and Fortimus, NOT for Minimus2 and Minimus Lite. Therefore, 
for Minimus2 and Minimus Lite only the rows with EEW transform 
disabled are relevant. 

 

5.2.7 Triggering Test Tool 

In order to see the event locator and logging operate without the need for a real event, 
Güralp has written a test tool that generates fake trigger events and sends CAP 
messages. with an ‘epicentre’ within the geographic region specified. 

The test tool is installed in the Program Files folder under Guralp Systems / 
Discovery2. Simply double click ‘thing.exe’ 

 

Figure 30 Discovery's test tool 
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First, enter the IP address of the CAP receiver (the computer running Discovery), in 
the Destination IP field. To find out the IP address of a Windows computer, key 
Windows + R to open the "Run" dialogue, enter cmd and press the Enter key. Type 
ipconfig in the terminal. Look for the right network adapter (e.g. Wi-Fi or Ethernet). 
The IP address will show next to the IPv4 Address entry. 

 

Figure 31 CAP sender Test Tool 

The number of instruments can be specified under Num Sensor, such that triggers are 
randomly generated from these instruments and create arrival times consistent with 
a simulated ‘epicentre’ within the geographic region specified. The maximum PGA 
can also be specified. 

5.3  MiniSEED Extractor 

The miniSEED extractor serves two purposes: 

• When an SD card is quick-formatted, each file is marked as unused but previously 
recorded data can still remain in them. Subsequent recordings overwrite these 
files from the beginning but, if the previous recording had a longer duration, old 
data will remain in the files. When the files are copied from the SD card to a PC, 
these older data can cause problems. 

• The format used on the SD cards consists of fixed-length, 128 MiB files. Some re-
cordings might not use all of this space. When the files are copied from the SD card 
to a PC, this can cause wasted disk space. 

The miniSEED extractor reads miniSEED files on the PC and copies them to a selected 
Destination folder, keeping track of the latest block time-stamp as it goes. If it encoun-
ters either an unused block or a time-stamp which is earlier than the previous one, it 
stops copying, truncating the output file at that point. This guarantees that each out-
put file contains only blocks in time order and contains no wasted space. 

To use the tool, select "miniSEED Extractor" from the Edit menu. Click the 
first Browse button to select which files you wish to process and then the second 
Browse button to select the folder into which you wish the output files to be written. 
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Finally, click the Trim Files button to extract the valid data from the selected files into 
new files in the selected destination folder. When the process reaches 100% the win-
dow can be closed and the trimmed miniSEED files can be found in the chosen folder. 

5.4  MiniSEED Gap Reporter 

This tool can generate a report of any gaps in the data from the input files. To use, up-
load the desired input and then click Gap Report to view the report of all files or just 
selected files. 

5.5  Command Scheduler 
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6  Data Visualisation 

6.1  Streaming data into Discovery 

6.1.1 Streaming protocols 

Discovery offers a versatile live waveform/data viewer. To open the Waveform 
Viewer, in Discovery’s main window, select an instrument, right-click on it and select 
Live View. The menu will then present options for data streaming, either GDI or 
Seedlink. 

 

Figure 32 Discovery main window and Live View options 

The Seedlink option utilises the industry standard SEED protocol, allowing the user to 
stream data from a single instrument or an instance of the Güralp Data Centre (GDC). 
For more information on GDC and Seedlink archive, see Section 8.6.4.  

All newer systems support the GDI protocol. The GDI protocol streams data sample-
by-sample and provides a low-latency data link for seismic data, both time-series 
(sample) and state-of-health information. These much smaller packets of samples 
allowing for a faster time-to-receive and a smoother feeling live stream. 

The GDI protocol also allows the sending of each instrument's calibration parameters 
so that data can be expressed in terms of physical units rather than digitiser counts. 
This is discussed in more details in Section 6.1.2. 

The main features and controls of the Live View window are introduced in Section 
6.1.3. 
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6.1.2 Metadata 

 

Figure 33 Example of metadata available by hovering over GDI channel 

GDI metadata consists of name/value pairs of text. The above list shows a typical set 
of metadata from a digitiser seismic channel, which appears when hovering on the 
GDI channel. Most of the metadata is sent only once on the connection of the channel.  

Metadata can be edited using the View/Edit Metadata function, accessible by right-
clicking on the waveforms. Gain and response parameters can be manually 
overwritten, but this is lost when a new connection is made. This can be used as a 
quick diagnostic tool. The metadata can be modified in a permanent way through the 
Calibration Editor. 
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M-CAL represents the scaling factor used for the conversion from digital counts to 
physical units. M-CAL is the product between M-GAIN0 (the digitiser’s sensitivity 
expressed in V/counts) and M-GAIN2 (the sensor’s sensitivity expressed in m/s/V for 
a velocity instrument and m/s2/V for an acceleration sensor). 

Changing the value of M-DISPCOLOUR will result in the stream being drawn with a 
different colour. 

A Seedlink stream to a Guralp device will automatically request the dataless file. This 
file is the SEED protocol for metadata. On receiving the dataless file the stream will 
populate the metadata with units, gains, poles, zeros, etc.  

 

6.1.3 Waveform Viewer 

To open the waveform viewer, right-click on an instrument in Discovery’s main 
window and select Live View. 

More than one instruments can be selected by clicking on their entries while holding 
down the Shift key (to select a range of instruments) or the Ctrl key (to select each 
instrument individually). 

6.1.3.1 Waveform Visibility 

The left tree display (Channel List)  allows individual streams of data to be made 
visible or hidden from view. The Clear All and Select All  buttons remove everything 
from view and display all the streams, respectively. 

 

Figure 34 Channel List check boxes control waveform visibility 

Right-clicking on one of the channels offers access to filters to apply visibility over all 
available channels (also across different instruments). There are three different filter 
options presented: 
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Figure 35 Context menu offers filters 

• Toggle Seismic – A quick and simple way to toggle on or off all the seismic 
channels (ending Z/N/E). The selection choice is set in a config option 
‘SeismicToggleBands’ which can be set in the advanced settings. It is a list of the 
acceptable seedname values for the first character in the channel code: 

 

Figure 36 Searching the advanced settings for 'band' to edit 'SeismicToggleBands' 

• Toggle Preset – Automatically generated possible searches based on the hierarchy 
of the Channel List 

• Toggle Custom - A simplified expression search filter where “*” is used as wildcard 
and “,” is used to add more filters. 
 
Some filter examples:  

• *Z → select all channels with names ending in ‘Z’ 
• *ACCN2, *ACCE2  → select all acceleration channels (tap 2) for horizontal 

components 
• *Timing* → select all channels with timing information 
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6.1.3.2 Channel metadata 

As mentioned previously, GDI channels and Seedlink with dataless carry metadata in 
addition to the sample stream. This can be displayed by right-clicking on a channel 
and select View/Edit. 

For GDI, the values can be modified such that other applets use the new values. The 
modifications remain until restarting the application. 

 

 

Figure 37 Metadata access from Channel List context menu 



Güralp Discovery - Software Manual  Data Visualisation 

MAN-DIS-0001 54  

 

6.1.3.3 Selection mechanism 

Dragging the mouse with left-click extends the selection. Once a temporal selection 
has been made, the channel makeup of the selection can be altered.  

Use Ctrl + left-click on other individual channels within the selected region to toggle 
their inclusion.  

Use Shift + left-click to extend the selection across multiple channels. 

When no key modifier is used, dragging the mouse with left-click over a waveform 
shows the maximum, minimum and average (in terms of mean and RMS) values for 
the selection. These values are typically expressed in physical units, with the counts 
shown in brackets. 

 

 

 
Figure 38 Left-click and drag selection of waveform 
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Figure 39 Use Ctrl + left-click to select two channels not close to each other 

 

Key modifiers (Shift, Alt) changes the annotated text to depict different signal 
statistics. 

• Shift → The mean of the selected waveform if subtracted from the min and 
max. The range (difference between min and max) is also shown. 

• Alt → The integral (area between signal and mean), the time in seconds 
between min and max and the ratio of min/max are displayed. 

Using the Alt key changes the numerical annotation of the selected waveform as 
shown below. Using this feature to analyse a seismic instrument’s step response  will 
display damping factor and estimated long period corner in seconds.  

 
Note: This approach to instrument verification is relatively quick to 
achieve an estimate of the instruments frequency response but it is 
highly broadband noise calibration is performed for a better, more 
accurate measurement. 
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Figure 40 Step response analysis with Alt Key 

6.1.3.4 Saving Files 

Portions of waveforms displayed in the Live View window can be saved to your PC in 
miniSEED format. In order to do this, highlight the section of waveform you want to 
save, right-click on it, and select Save as mseed. Multiple waveforms can also be 
selected as described in Section 6.1.3.3.  

Various files are saved in the chosen directory, specifically: 

• One file in miniSEED format for each channel selected, named after the 
channel name, which contains the highlighted portion of waveform 

• One dataless file 

• One file called all.mseed in miniSEED format, which contains multiple traces 
from all the channels selected. 

If channels from more than one instruments are selected, the files from the different 
instruments are saved in folders named after the serial number of the devices. Each 
folder contains the same files as specified above. 

Mean level of last 
10% of step 
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6.1.3.5 Window Control Short-Cuts and controls 

You can change the display of the waveforms with based on a combination of key-
strokes and mouse wheel and menu buttons. These commands are shown in the 
tables below: 

 

Table 2 List of commands to change waveform display 

Command Window control 

<<>> Extend view over all available data 

>> Show most recent minute or so of data 

>>> Show most recent few seconds of data 

Ctrl + mouse wheel Pan time-scale right/left 

Shift + mouse wheel Zoom time-scale in/out 

Mouse wheel Scale amplitude of all traces 

Mouse wheel – over trace label Scale amplitude of that individual trace 

Right Click Context menu – Zoom 
in 

Re-zoom whole display to show the selected region only 

Right Click Context menu – ReZero Remove mean from the selected portion of the 
waveform 

Double left-click over Channel Stats Magnify that channel 

R Key When in Waveform Context Re-scale and re-zero channels individually to be visible   

+ Key When in Waveform Context Change offset to bring last 10% into view 

Mouse Wheel Over Channel Info 
Text 

Zoom that one stream independently 

Mouse Wheel Over Channel Info 
Text +Shift 

Move that one stream’s offset 

Mouse Wheel Over Channel Info 
Text +Control 

Fine move that one stream’s offset 

 

The overall waveform window scaling and offset of channels is controlled by the 
buttons above the waveforms. These change all the channel’s zoom and offset values 
in one ‘hit’. 
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Figure 41 Scale, Offset and Zoom controls in Live View window 

 

Table 3 Summary of waveform zoom and offset controls 

Button Scale Offset Comments 

Fit to view 

(formally Reset) 

Each channel 
scaled to fit 

Set to the 
channel’s mean 

A quick way to 
guarantee 
actually seeing 
something 
irrespective of 
any channel 
offset or signal 
size 

Normalise Reset Zoom to fit 
the biggest 
waveform. Other 
channels given 
the same zoom 

Set to the 
channel’s mean 

Useful to 
compare relative 
size of multiple 
instrument’s 
response to an 
event. 

Live No Effect Dynamically set 
to the mean of 
the channel’s 
recent data. 

Toggles Live 
mode. 

Manual 

(formally Centre 
Streams) 

No Effect Call All once. Toggles Manual 
mode. 
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All No Effect Set to Channel’s 
Mean 

Manual mode 
only. 

Recent No Effect Set to the mean 
of the channel’s 
recent data. 

Manual mode 
only. 

 

 

6.1.3.6 Window Tools 

There are 3 tools available within the waveform window to assist in analysing the 
trace data. 

 

Figure 42 Waveview Tools 

 

From left to right these tools do the following: 

1 – Stream Marker Labels - Used to highlight any gaps or overlaps. 

 

Figure 43 Stream Marker Labels showing gap in data 
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2 – Vertical Time Bar – Allows user to pinpoint the time of a specific event in the 
stream data. 

 

Figure 44 Vertical time bar being used to analyse a specific seismic event 

 

3 – Connection Events –A live list of connection events. Useful for gaining 
understand of what is happening in terms of device connection, disconnection and 
re-connection.  
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Figure 45 Connection Events Widget 

 

All tools can be enabled/disabled easily via the Wave View page. 

 

6.2  Offline Data 

MiniSEED data can be loaded directly into the viewer from files. Open the data viewer 
from the Tools menu. Clicking on the Load data option from the top of the viewer 
screen opens the file dialog for this purpose. 

MiniSEED data can either be loaded from file(s) or from directory. This second option 
will be explored in Section 6.2.2. MiniSEED files can also be loaded by dragging them 
into the Viewer. 

A miniSEED file stores time series data with very limited metadata (time series 
identification and simple SOH flags). Therefore, when a miniSEED file is uploaded 
alone, the time series is displayed in counts.  

The metadata, including the instrument response, is contained in the dataless SEED 
volume. To visualise the time series in physical units the dataless SEED volume is 
needed. 

 

Figure 46 Load data option from the Live View window 

6.2.1 Upload Metadata 

Metadata (calibration, gains etc) is loaded from a .dataless file. Choose a file of this 
extension and any matching seed channels will display gains, units etc in their 
respective metadata from then onwards. 
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First, drag into the Data Viewer or upload the dataless file. Then, drag or upload the 
correspondent miniSEED file(s). Alternatively, load miniSEED and dataless file 
together. Now your waveforms will be displayed in physical units. 

The dataless file can be offloaded from any Güralp digitisers from the Storage tab of 
the webpage. 

 

Figure 47 Upload the dataless SEED file together with the miniSEED file to display the waveforms in 
physical units 

6.2.2 Directories and Filters 

As mentioned previously, there is an option for loading files from a directory (folder). 
If this option is chosen, a later dialog will ask if you want to filter the loaded files 
depending on the filenames by using the wildcard *.  

Some examples: 

* → load all the files in the directory 

*SeisZ* → load all the Z channel data  

EVENT* → load all the files generated as a result of triggers 

*Rot* → load all the files with rotation information (yaw, pitch and roll) 

DG* → load all the files with network code DG (including dataless file if available) 

This feature is based on the matching of the filenames, so the expressions may vary 
depending on the instrument. 



Güralp Discovery - Software Manual  Data Analysis Tools 

MAN-DIS-0001 63  

 

7  Data Analysis Tools 

Data analysis tools are available for both real-time data (Live Viewer) and offline data 
(Data Viewer). 

 

Once the waveform viewer is opened and the desired streams are displayed, selecting 
a portion of waveform and right-clicking on it gives the user access to various 
processing applets. These generally accept a block of samples from the selected 
region and perform a function that may then lead to a graph or dialog. Most of the 
applets either accept multiple channels and would overlay results or launch one 
instance of the applet per stream, as applicable. 

The following sections describe the main applets available. 

 

Figure 48 Right-click context menus 

 

Note:  When offline miniSEED files are uploaded to the Data Viewer tool, 
remember to upload also the dataless file before performing data analysis 
(see Section 6.2.1).  
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7.1  Plots 

7.1.1 PSD 

 

Figure 49 Example of PSD of 3 components of an instrument 

 

Clicking on Plot → PSD allows you to plot of the Power Spectral Density (PSD) of 
selected data. More than one streams can be selected simultaneously to overlay the 
results. The PSDs of your data will overlay the new high- and low-noise models 
(NHNM and NLNM, respectively). 

This operation deconvolves the instruments response with the poles, zeros and gain 
extracted from the channels metadata. The PSD is calculated from the signal in 
various, overlapping, finite-length windows within the data selection. The window 
function, overlap and step can be set by right-clicking on the selection of data, and 
selecting Windows.  

The plot can be zoomed in/out by using the mouse and modifier keys as follows: 

Mouse Wheel – Change overall zoom 
Shift + Mouse Wheel – Horizontal zoom only 
Ctrl + Mouse Wheel – Vertical zoom only. 

Toggle visibility of 
respective graph 

Save as PDF, JSON, or PNG/JPG  

Load JSON to create overlay 
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Clicking on the entry of a specific channel in the legend box will remove that line 
from the graph. Click on it again to re-add the line. 

PSDs can be saved in different formats, including PDF, JSON and JPG. JSON files can 
be loaded into your graph to create overlay.   

 

7.1.2 Min PSD 

In order to show the instrument’s best performance over a period of time, the user 
should compute the Min PSD, which can be done by clicking on Plot → Min PDS.  

For the calculation of the Min PSD, the PSD is computed multiple times at increasing 
time offsets. The power measured in each frequency bin is then minimised across all 
the PSDs that have been calculated, so that the effect of local impulse noise is 
removed. This presumes that a large amount of source data is selected, typically 12 or 
24 hours. This is an intensive operation that takes advantage of multi core hardware. 

The statistical spread of the instruments output is represented as is the mode. 

 

Figure 50 Example of Min PSD 

7.1.3 Self Noise 

The measurement of an instrument’s self-noise requires a second instrument which 
is used as a reference. The reference instrument must be precisely aligned with the 
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instrument under test. During the computation of the self-noise, the common signal 
between the two instruments is eliminated, leaving only the non-coherent signal. 
The residual noise is plotted as indication of an instrument’s performance. 

To generate a self-noise plot, at least two streams must be selected. The first stream 
serves as a reference and corresponds to data from the reference instrument. 
Subsequent streams represent the instruments for which the self-noise is being 
calculated. Once the data is selected, right-click on the selection and choose Plot → 

Self Noise.  

7.1.4 Min Self Noise 

 

7.1.5 Spectrogram 

A spectrogram is a visual representation of how the frequency content of a seismic 
signal changes over time. The Spectrogram function thus generates a spectral plot 
over time. It is designed to spot typically anthropomorphic noise picked up by a 
sensor such as vibration from motors, engines, vehicles etc. 

The horizontal axis represents the time duration of the selected seismic recording. 
The vertical axis shows the frequency content of the signal in Hz. This axis of the 
spectrogram is linear, with the maximum corresponding to the Nyquist frequency. 
The colouring represents the energy at each frequency over time, and it follows a 
logarithmic scale. 

The plot can be zoomed in/out and modified by using the mouse and modifier keys as 
follows: 

Mouse Wheel – Change overall zoom 
Shift + Mouse Wheel – Horizontal zoom only 
Ctrl + Mouse Wheel – Change colour palette  
Left Mouse drag – Move X,Y 
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Figure 51 Example of a spectrogram for a 250sps channel 

7.1.6 Transfer Function 

 

Figure 52 Plot of the transfer function based on metadata poles/zeros 

The poles and zeros from the selected channel are plotted as a Bode plot giving phase 
and magnitude response of the instrument. Note that this applet does not compute 
the poles and zeros, but only plots the transfer function based on the poles and zeros 
already supplied. 

 

Mains power 
induced  vibration 

Impulse noise  
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7.1.7 Channel coherence 

This tool measures the similarity between seismic signals recorded at two different 
stations or channels as a function of frequency. Amongst various uses, coherence 
results can help to identify common signals (high coherence means that signals are 
part of the same seismic event), to assess stations performance (low coherence may 
indicate sensor issues or poor site conditions),  to assess site amplification effects 
(coherence between vertical and horizontal components). 

 

Figure 53 Example of coherence plots between the East channels of two co-located seismometers 

 

7.1.8 Channel correlation 

This tool performs a time domain correlation between selected channels. To plot the 
correlation between two desired channel, select a portion of data from one stream 
(which will be deemed the reference) and then Ctrl + Click on the second stream. 
Right-click and select Plot → Channel correlation. 

The data is windowed (using the Hanning function) before the correlation is 
computed. For the computation of the correlation one signal is shifted continuously 
towards the reference, and for each time-shift the value of the correlation is 
calculated. A peak at the mid-point (marked zero on the output) shows how similar 
(correlated) the channels are. 

This tool can be used to calculate the time offset between channels even if the data is 
not identical. For example, it can be useful in order to measure the time delay 
between two seismometer channels. The numerical time offset is displayed in the 
text region below the graph. 
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Performing this on a single channel plots the autocorrelation function of the data. 

The left hand graph shows the same data as the right hand but at an oversampled 
(x100) rate. This allows a more accurate, sub-sample time period to be measured. 

The graphs can be panned and zoomed with the mouse wheel and control and shift 
keys as follows: 

Mouse Wheel – Change overall zoom 
Shift + Mouse Wheel – Horizontal zoom only 
Ctrl + Mouse Wheel – Vertical zoom only 
Left Mouse drag – Move X,Y 

This applet can be also used to correlate a calibration signal (for example, a sine 
wave) and the instrument’s output. The values reported in the text box below the 
graphs can be used for gain calculation and phase analysis. For more information, the 
reader is referred to Section 7.2 . 

 

7.1.9 Alignment 

This function attempts to align a subject sensor to a reference by rotating the subject 
data through a series of angles and comparing it to the reference via their coherence, 

Measured relative magnitude and delay  
of instrument output compared to 
excitation. 

These figures can be compared with a 
table provided in a CSV file to verify 
instruments performance 

Figure 47 Correlation between calibration signal and instrument output 
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over the specified frequency range. The angle between the sensors is determined by 
finding the highest coherence, the mean squared error is used to check for a 180° 
offset (coherence is a function of power and therefore will give the same result 
whether or not the subject is inverted). 

The alignment plot is used primarily to find the yaw (clockwise rotation around the 
vertical axis) of the subject. In its most basic form one horizontal channel is needed 
as a reference, while all subjects will need both their N/S and E/W channels. With 
channels selected in this manner the reference drop down in the dialog will contain 
only one possible option and the “Subject Starting Orientation” controls are disabled. 

If the both the horizontal channels are selected for the reference the subject will be 
evaluated against each in turn, with the final result being the sum of the N/S and E/W 
coherences. If all three channels are provided for the subject, you can specify starting 
roll and pitch angles (can be taken from the sensors MEMS accelerometer channels if 
it has them).  

Figure 54 Alignment Dialog 

Finally if all three axes for both the reference and subjects are selected, the option to 
apply a “3D small angle correction” will appear. This searches for the best total 
coherence while rotating the subject around all three axes (roll, pitch and yaw) over a 
±4° range.    

The reference and subject steams need to have the same sample rates and should 
have the same response (poles and zeros) although this is not essential if they have a 
good match over the specified frequency range. Comparing sensors with different 
unit types (e.g. acceleration against velocity) is not advised as it can give odd results. 

Once Discovery finishes processing you will get an alignment plot for each subject. 
This shows the coherence and mean squared error versus yaw angle and replots the 
selected reference timeseries data against the newly rotated subject.  

Specify the frequency range over 
which to compare the reference and 
subject via coherence and mean 
squared error. 

Defaults to the micro-seismic peak, 
this seems to give the best results 
especially from quiet data. 

Allows you to specify a starting roll 
and pitch for the subject relative to 
the reference. For example, if the 
reference is level this can be read 
straight off the subjects MEMS 
channels. 

Choose which instrument 
to use as the reference.  

If any of the instruments 
only have one horizontal 
channel selected this will 
be the only choice. 
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Figure 55 Alignment plot 

The notes section will give you the angle with best coherence found and provide a 
quaternion equivalent to this rotation which can be applied directly to the subject 
sensor via the transforms tab of its digitizer webpage.  

7.2  Setup Calibration Emails 

This function can be performed as a superset of the Correlation function above 
(Section 7.1.8). 

An instrument can be ‘excited’ with a test signal – typically a sine wave. 

 

Figure 56 Typical output during calibration with a Sine Wave 

The output of the instrument can be correlated with the excitation signal and then 
the results tested between limits to decide whether the instrument is working as 
expected. 
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These limits can be set through Discovery, according to the frequency and type of 
excitation. 

Two measurements are made on the correlation. The first is the time offset between 
the excitation signal and the instrument output. This measures the phase response of 
the instrument. The second is the relative amplitude of the instrument’s output as 
compared to the excitation amplitude. This relates to the instrument’s gain. 

Numerical values of the phase and magnitude are calculated and saved to a log file. 

This function is enabled in the digitiser by performing a Sine Wave Calibration. The 
action of turning off the calibration triggers the analysis automatically. 

 

Emails can be configured to be set out when the sine wave calibration signal is sent. 
To do this, right-click on the Wave Viewer and select Setup Calibration Emails. 

 

Figure 57 Setup calibration email window 

This window will assist with setting up emails to notify the success or failure of 
correlating calibration data of ZNE streams, based on the thresholds indicated in the 
table. 

Note: the Calibration channel needs to be enabled on the digitiser. 
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The required threshold can be inserted into the table either manually or by loading a 
*.csv file with 5 columns. These columns will contain: 

- The type and frequency of the excitation as it appears on the 
instrument’s webpage (“Signal”) 

- The threshold for the time offset between the excitation signal and the 
instrument output in ms (“Delay threshold”) 

- The tolerance of the time offset (“+/-“) 

- The threshold for the relative amplitude of the instrument’s output as 
compared to the excitation amplitude (“Gain threshold”) 

- The tolerance of the relative amplitude (“+/-”) 

 

The 2 lines below represent an example of valid entries for the csv file: 

Sine Wave 2 s 64522 845 0.248123 0.03 

Sine Wave 1 Hz 53812 124 0.248123 0.02 

 
Any lines in the csv file that do not contain 5 items will be discarded. Blank data is 
accepted. However, these rows will not be read when reading calibration data.  

Note: the type and frequency of the excitation in the “Signal” column 
has to be written exactly as it appears in the label of the calibration 
channel in Discovery’s Live View (i.e. “Sine Wave 1 Hz”). If you do not 
see any labels, click on the icon with the symbol in the figure below 
(under the Tools section). If you do not see the label at the beginning of 
the calibration signal, you may need to upgrade the instrument’s 
firmware. 
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If your smtp server requires authentication, tick the “Auth required” box and fill in the 
“Username” and “Password” fields. If authentication is not required, do not leave the 
box un-ticked and the “Username” and “Password” fields empty. 

When adding emails to the recipients list, separate them with a comma (','): 

someone@example.com, someoneelse@example.com  

Once the email settings have been filled in, send a test email by clicking on Send Test 

Email. If the test email was successful, click Enable to complete the setup. Your 
password will not be stored, so this feature will need to be reenabled if Discovery is 
restarted. 

 

The action of turning on and off the calibration signal basically triggers the Channel 
Correlation applet, which performs the correlation between the excitation and each 
one of the three seismic channels. The results of the three correlations will appear on 
the same plot as in the figure below. 

Note: If this error message appears when trying to send the test email 
on a Windows machine, try to run Discovery as administrator. 
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The success/fail email will be sent once a calibration signal that matches a row in the 
table is started and then switched off. 

If there are fewer than 10,000 samples the email will not be sent as the data set will be 
insufficient.  

Below is an example of the curl script used to send the email: 

curl --url 'smtp://mymailhost.com:25' --mail-from 

me@mymailhost.com' --mail-rcpt ‘whoever@mymailhost.com' -vv --

upload-file 

 

Success and failures will also be logged to the location specified in this window to a 
fie called “Calibration.log”. The location of the log file can be changed using the 
button Change Log Location. 

7.3  Filters 

Filters are an essential tool in seismic data processing. The main types of filters are: 

- Low-pass filters: they allow lower frequencies to pass through while 
attenuating higher frequencies 

Note: To send emails, curl must be installed on your system 
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- High-pass filters: they allow higher frequencies to pass through while 
attenuating lower frequencies 

- Band-pass filters: they allow only a specific range of frequencies to 
pass through while filtering out the others. A combination of low-pass 
and high-pass filter can be used to create a band-pass filter. 

Filters are typically used for the following purposes: 

- Remove unwanted noise from various sources, such as ocean waves or 
human activity 

- Enhance signals of interest or different seismic phases 

- Spectral analysis to study earthquake source properties and site 
effects 

- Instrument response removal, along with deconvolution techniques. 

Discovery offers both real-time filters and non-real-time filters, as detailed below. 

7.3.1 Real-Time Filtering – Inbound Filters 

Filter can be applied in real-time to data coming into Discovery (inbound). Either a 
low-pass, high-pass, or combination of both can be used. Since these filters are 
performed in real time, they are causal in nature. In short, causal filters are filter 
where the output at any given time depends only on the past and present inputs, and 
not future inputs. This makes them suitable for real-rime processing applications. All 
inbound filters will be remembered and applied the next time a stream is opened. 

To add a filter to data streamed to the Discovery Live Viewer, right-click on the 
channel summary and select Inbound Filters.  

 

Figure 58 Right-click to apply real-time filters 

This action opens the “Inbound Filters” widget. 
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Figure 59 Inbound filters widget 

All channels visible in the Data Viewer will be listed and the one used to open the 
widget will be automatically selected and checked. Multiple channels can be selected 
by ticking the relative boxes. The Composition section of the widget allows the user to 
choose which type and order of filters to apply to the selected channels. A 
combination of high-pass and low-pass filters can be used to achieve a band-pass 
filter. When Apply or OK are pressed, the current composition will be applied to all 
channels in the list that are checked. After setting a filter on a channel it will show up 
on the channel summary: 

 

Figure 60 Channel with filter applied 

Note: Inbound filters are applied to data coming into Discovery. This 
means that any analysis done on a filtered channel will be done on 
filtered data.  
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7.3.2 Non Real-Time Filtering – Filter+  

The Filter+ applet allows you to apply filters to non-real-time data. These data can be 
either miniSEED files loaded into the Discovery’s Data Viewer (together with the 
relative dataless file – see Section Error! Reference source not found.), or a selection 
of data streamed to the Live Viewer. 

To select a section of time-domain signals on one channel, right-click on the 
waveform and drag to make a selection. To then select multiple channels, click on 
them while holding the Ctrl or Shift key. Once the desired data have been selected, 
right-click and choose Filter+. This action opens the “Filter+” widget. The Replot 
button is used to re-plot the data after any filter or other options have been selected. 
Click on the Replot button also to visualise the data upon opening the Filter+ widget 
(otherwise, no data is displayed). 

 

Figure 61 Filter+ widget 

Tick the Use Cal box to visualise the data in physical units rather than digital counts. 
When this box is ticked, the data is scaled using the scaling factor represented by M-
CAL (see Section 6.1.2). Tick the Auto Scale box to automatically optimise the view. 
Tick the Remove DC box if you want to plot the data centred around zero. If multiple 
streams have been selected they may overlap, making it difficult to distinguish the 
features of each waveform. Tick the Spread box to centre the data from each channel 
around different values, ensuring all waveforms are visible simultaneously. Note that 
when this box is ticked the vertical label loses its meaning. 
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Figure 62 Ticking the Spread box allows you to visualise multiple waveforms simultaneously 
without overlaps 

At the top-left of the Filter+ window, low-pass and high-pass filter options (hence 
band-pass filters) are implemented. The order of the filter can also be set. The Linear 

Phase check boxes are used to perform symmetrical (forwards and backwards, or 
acausal) filtering, which ensures that the timing of edges for picking remain the 
same. 

Both the original input and filtered output can be displayed as shown below. 
Individual traces can be hidden or revealed by clicking the names in the legend on 
the top-right. 

 

Figure 63 Filter+ Applet displaying original and filtered traces 

The Deconvolve check box performs a deconvolution of the time-domain data using 
the instrument’s response (poles and zeros). Typically, for a seismometer this is a 
bandpass response. This results in a boost for the low and high frequencies as the 
plot below demonstrates. 
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Figure 64 Low-pass filter and Deconvolution with cursors 

Waveform statistics can be displayed by ticking the Stats box. To view true peak 
ground motion, use the Cal option and the Deconvolve option. Typically, also the 
Remove DC option is used to eliminate instrument drift when looking at the PGA of 
an event. 

See below for an example. 

 

Figure 65 Stats display to the right of the waveforms 

A PDF report can be generated for Filters+ with the pdf button. This will catalogue the 
filter options used, including: timestamps, deconvolution, and any pass filters applied. 
It also displays the plot of waveforms followed by a table for each waveform detailing 
the min/avg/max and, if they are from seismic channels, the PGA/PGV/PGD. An 
example output follows. 
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Figure 66: PDF report for applying M-CAL, DC removal, deconvolution, and a first order high pass 
filter to a selection of two streams. 

Filter+ also allows you to select a time window within the Filter+ widget and 
automatically highlight the corresponding data segment in the Data Viewer. To do 
this: 

- Hold down the Ctrl key and left-click at the desired start time. A red 
line will mark the selection start.  

- While still holding the Ctrl key, right-click at the desired end time. A 
yellow line will mark the selection end.  

- The same time window will automatically be highlighted in the Data 
Viewer as shown in the image below. 
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Figure 67 Time selection of data in the Filter+ widget and corresponding data in the Data Viewer 

A possible application of this feature is related to the computation of an instrument’s 
PSD (see Section 7.1.1) for performance assessment. For an optimal performance 
evaluation of the instrument, data should be selected from quiet periods. Usually, 
nighttime data are used, when human activity is at its minimum. Applying filters 
before computing a PSD can help in selecting the best data. In fact, filtering the data 
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can emphasise transient events (e.g. spikes and glitches) that would otherwise not be 
visible.  

The figure below shows an example of how filtered data (green) can reveal spikes that 
are not visible in the original waveform (grey).  

 

Figure 68 Example of filtered data revealing spikes not visible in the original waveform 

For the computation of a PSD for performance analysis, a time window which 
excludes the spikes should be selected. This can be done in the Filter+ widget as 
explained above. This action will highlight the corresponding time selection in the 
Data Viewer, which can then be used to compute the PSD. 
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8  Güralp Data Centre (GDC) 

8.1  Concept & Purpose 

Güralp Systems Data Centre software package (acquisition software package) consists 
of several applications with the primary purpose of acquiring, saving and re-
distribute miniSEED data. It also provides system state of health monitoring and 
distribution, with remote configuration capabilities. 

 

8.2  Software Components 

- IRIS ringserver 

- slinktool 

- slink2dali 

- Güralp Data Centre controller service 

- Güralp Data Centre monitor service 

- Güralp responder service 

- Güralp Discovery application (NOT Deployed on GDC server) 

Optional components: 

- Earthworm client 

- SeiscomP3 client 

 

8.3  Operating System Compatibility 

Güralp Systems Data Centre software package has been tested on the following 
x86_64 platforms: 

- Red Hat Enterprise Linux 8 (or equivalent, e.g. Rocky Linux 8 or AlmaLinux 8) 

- Amazon Linux 2 
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8.4  Open Ports 

The GDC requires access to the network to operate correctly. Please make sure that 
the system security settings allow the network traffic to and from the machine on 
ports specified in the table below. It also might be needed to configure SELinux 
features in relation to the mentioned requirements. 

Table 4 Ports that have to be open for GDC 

Port  Protocol Description 

11788 UDP 
Used for sending and requesting state of health 
information by system components and 
Discovery desktop application. 

11788 TCP 
Configuration exchange protocol used by 
Discovery desktop application to configure data 
streaming connections. 

16000 TCP DataLink data transmission protocol connection 
to IRIS ringserver. 

18000 TCP 
SeedLink data transmission protocol connection 
to IRIS ringserver for both incoming and outgoing 
data streams. 

8.5  GDC Configuration 

8.5.1 IRIS ringserver 

IRIS ringserver does not require any specific configuration unless change in either 
default storage location (/var/cache/guralp/miniseed/) or time for which the data is 
kept on the hard drive is required. Application runs as an operating system service 
and listens for SeedLink connections on TCP port 18000. If required listening port is 
different to 18000 please contact support@guralp.com for instructions. 

8.5.2 Ringserver miniSEED files storage location configuration 

IRIS ringserver storage location is configured by the home directory of ringserver user 
and if required can be changed by system administrator by editing the user 
properties. This can be done via SSH into data centre. Newly selected directory should 
have sufficient permission and ownership. The steps below show how to modify the 
home directory of the ringserver user in Red Hat Linux environment (please note that 
commands may require elevated permissions). 

a. Copy tmpfiles.d guralp-miniseed.conf file to /etc system location 
 

cp /usr/lib/tmpfiles.d/guralp-miniseed.conf/etc/tmpfiles.d/guralp-miniseed.conf 
 

mailto:support@guralp.com
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b. Edit the copied configuration file and append a new line specifying the new storage 
location: 

 
  d  /run/guralp/etc                         0755 root    root 
 F  /run/guralp/etc/iris-ringserver.conf    0640 root    ringserver   -   

MSeedWrite %%n_%%s_%%l_%%c_%%Y_%%j.mseed 
 d  /var/cache/guralp/miniseed              0775 root    ringserver       3d 
 d  /mnt/new/storage/directory              0775 root    ringserver       3d 

 

c. Save the changes made to the file 
 

d. Modify the ringserver user home directory 
 

 usermod -d /mnt/new/storage/directory ringserver 
 

e. Reboot the system to apply the changes. 
Please note that only the following top directories can be used: /home /media /mnt /opt /srv /var 

 

8.5.3 Ringserver miniSEED files storage auto-clean configuration 

IRIS ringserver storage is controlled by system tmpfiles clean timer and can be configured 
by editing guralp-miniseed.conf file. To change the configuration of time that historical 
data is kept in the system please follow the steps below. 

a. Copy tmpfiles.d guralp-miniseed.conf file to /etc system location 
 
 cp /usr/lib/tmpfiles.d/guralp-miniseed.conf/etc/tmpfiles.d/guralp-miniseed.conf 

 

b. Edit the copied configuration file and change the age of storage location to the required 
value. 

 
d  /run/guralp/etc                          0755 root      root 
F  /run/guralp/etc/iris-ringserver.conf     0640 root      ringserver       -   

MSeedWrite %%n_%%s_%%l_%%c_%%Y_%%j.mseed 
d  /var/cache/guralp/miniseed               0775 root      ringserver       3d 
 

where 3d is the age of temporary files (read more: 
https://www.freedesktop.org/software/systemd/man/tmpfiles.d.html). 
 

c. Save and reboot the system. 
 

8.5.4 Slinktool 

Slinktool process runs as a service with parameters provided through the service name 
in a form of a ‘@’ separated list of values. Under normal operation there is no 
requirement to manually configure (enable/disable or start/stop) the service, this task 
is performed by the Data Centre controller on remote request from the Discovery 
desktop application.  

https://www.freedesktop.org/software/systemd/man/tmpfiles.d.html
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Manual service configuration can be performed but it is not recommended. To do that, 
please log in to the Data Centre computer and use systemctl command to 
enable/disable and/or start/stop the Slinktool service. Slinktool service is run with a 
set of parameters: 

slinktool@NN@ST@LLCHA@CONNECTION@PORT.service 

where: 

- NN is the SEED network code. 
- ST is the SEED station code. 
- LLCHA, is SEED location and channel codes. 
- CONNECTION, is the connection IP address or hostname, for latency monitoring in 

the Data Centre this is set to 127.0.0.1 (localhost) 
- PORT is the connection port of the Seedlink data. 

 
Wildcard character for SEED location and channel name can be used and is 
represented by ‘_’ character. Also, a list of location and channel names can be provided 
to a given service and should be separated with ‘-‘character. 

Example: 

slinktool@DG@0585A@_____@127.0.0.1@18000.service, will connect to station 
0585A of DG network, subscribing to any channel (wildcard selector of 5x ‘_’ 

character). 

slinktool@DG@0585A@0NHHZ-0NHHN-0NHHE@127.0.0.1@18000.service, will 
connect to station 0585A of DG network, subscribing to 0N.HHZ, 0N.HHN and 

0N.HHE channels. 

8.5.5 Slink2dali 

Slink2dali process runs as a service with parameters provided through the service 
name in a form of a ‘@’ separated list of values. Under normal operation there is no 
requirement to manually configure (enable/disable or start/stop) the service, this task 
is performed by the Data Centre controller on remote request from the Discovery 
desktop application. 

To configure the required connection (slink2dali and Slinktool services) use the 
Discovery desktop application described below. 

 

8.6  GDC Discovery Interface 

After primary installation and configuration, the GDC is intended to run as a headless 
server. Further configuration, maintenance and SOH monitoring can be accomplished 
though Discovery. The purpose of GDC is to record data streams from multiple 

mailto:slinktool@NN@ST@LLCHA@CONNECTION@PORT.service
mailto:slinktool@DG@0585A@_____@127.0.0.1@18000.service
mailto:slinktool@DG@0585A@0NHHZ-0NHHN-0NHHE@127.0.0.1@18000.service
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sensors. This archive of miniSEED files is then available to applications on the Linux 
environment. 

The system also runs a SeedLink server that is capable of re-streaming any of the 
streams that are being recorded. Any SeedLink client can connect to this server to 
retrieve data. 

Discovery can be used as a SeedLink client also. In this mode, data can be viewed live 
without the need to pull a second stream directly from the device. 

8.6.1 Configuration - Adding a Station 

• Open Discovery desktop application and change the view to “Registry” mode. 
• Right-click on the Data Centre instance. 
• Select Configuration option. 
• In the configuration widget, if not preloaded with configuration, click on “Restore” 

button to retrieve the Data Centre configuration. 
 

 
Figure 69 Data Centre Configuration Controller 

 
• From here Devices on the same registry server can be added from ‘Add station 

from discovered.  



Güralp Discovery - Software Manual  Güralp Data Centre (GDC) 

MAN-DIS-0001 89  

 

• To apply configuration changes to device, choose ‘Apply’. Ensure that when adding 
devices that ‘Use tunnel connection’ is selected.  
  

8.6.2 State of Health 

The Data Centre state of health can be monitored in the real time either in the 
Discovery desktop application main window by checking the status indication icons, 
and/or by accessing the dedicated Data Centre state of health widget. 

 

Figure 70 Access to GDC state of health from Discovery's window 

The state of health dashboard widget is divided into 4 main parts as shown and 
described in the following Figures. 

 

 

Figure 71 Top-left widget is a latency graph displaying the highest historical latency value for up to 
last 30 minutes. 
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Figure 72 Top-right widget is a disk usage graph displaying the disk free space in MB (blue graph, 
left y axis) and disk used space percentage (red graph, right y axis) 

 
Figure 73 Bottom-left widget displays the state of services running on the Data Centre and allows to 
configure the logfile and output data file for activity log and latency/disk usage data respectively. 
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Figure 74 Bottom-right widget displays the activity log based on state of health information packets 
received. 

  

Log line contains the following information: 
- Timestamp 
- Latency value 
- Sample latency value 
- Number of active channels 
- Number of active devices 
- Latest sample timestamp  
- Available disk space in KB 
- Disk used space in KB 
- Percentage value of free disk space 

 
And is logged as single line in the following format: 

 
{[Timestamp]} Latency: {Latency value}s; Sample latency: {Sample latency 

value}s; Active channels: {Number of active channels}; Active devices: 

{Number of active devices}; Latest sample timestamp: {Latest sample 

timestamp}; Disk available: {Available disk space in KB}; Disk used: {Disk 

used space in KB}; Disk free: {Percentage value of free disk space}%; 

 
Example: 
 
[Fri Jul 9 13:50:34 2021] Latency: 1.50s; Sample latency: 1.81s; Active channels: 26; Active 

devices: 2; Latest sample timestamp: Fri Jul 9 13:49:43 2021; Disk available: 73364480; Disk 

used: 54698232; Disk free: 25.44% 
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8.6.3 Advanced redundancy configuration 

It is possible to have two data centre servers running concurrently. For advice on this 
more advanced configuration please contact Güralp at support@guralp.com 

8.6.4 GDC Restreaming 

Discovery can fetch live data directly from the GDC ring buffers.  

 

Figure 75 Context menu when selecting a GDC server 

Selecting the Mseed option will connect to the SeedLink server at the GDC instance 
and start live streaming of data into the Discovery Viewer. 

Dataless files for instruments re-streamed from the GDC can be placed in a folder: 

Linux: 

~config/Guralp Systems/Discovery/dataless/ 

Windows: 

C:\Users\<username>\AppData\Local\Guralp Systems\Discovery\dataless 

These files are read when a stream is first created. 

Alternatively, manually loading a dataless file using the Load Data button in the 
viewer has the same effect. The units and calibration should then appear in the 
viewer. Hover over the stream status to view the metadata associated with that 
channel. 

mailto:support@guralp.com
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Figure 76 Channel metadata originating from dataless file 

8.6.5 Viewing Instrument/Digitiser WEB configuration via GDC 

Typically, digitisers are connected to the GDC via a tunnel. This circumvents NATs 
and makes the connection more secure. Güralp digitisers have an inbuilt tunnel that 
can be enabled in the Network tab of the instrument. 

When such tunnels are implemented, the GDC retrieves Seed data using the SeedLink 
protocol. This travels via the tunnel. 

Access to the instrument’s web config page and other services can also be made via 
the same tunnel connection. 

When running Discovery as a local client, the tunnel is not terminated locally. 
Accesses to the WEB pages need to be forwarded through the GDC server. This is 
handled automatically. Right-clicking on the Tunnel column forces the local 
Discovery to access the instrument via the GDC. This avoids to need for separate port 
forwarding or additional  

 

Hover Here 
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Figure 77 Instrument Access 

Right-click in this columns 
to force tunnel access via 
the GDC 



Güralp Discovery - Software Manual  Discovery Configuration 

MAN-DIS-0001 95  

 

9  Discovery Configuration 

9.1  Config file 

Discovery reads a config file on startup. There are a number of options and 
parameters that can be changed in this file. The file is written when parameters 
change or when Discovery is closed. For this reason, editing of this file should be done 
after Discovery is closed. 

Linux: 

~/.config/Guralp Systems/Discovery/config2.ini 

Note: The space in “Guralp Systems”  may need to be escaped with a backslash when 
using some shell command lines:  

~/.config/Guralp\ Systems/Discovery/config2.ini 

 

 

Windows: 

C:\Users\<username>\AppData\Local\Guralp Systems\Discovery\config2.ini 

9.2  Data locations 
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10  Appendix 1 - Güralp Discovery 
Installation 

Güralp Discovery is a software package for Microsoft Windows, MAC and Linux, 
which facilitates the identification, configuration and management of Güralp 
digitisers and instruments. 

Güralp Discovery has a conventional .msi -based installer. Once installed, the 
software can check whether it is the current version and can update itself using a 
button on the Help→About menu. 

10.1  Installation in Linux 

The Linux version of Discovery 64-bit is delivered in a self-contained package. 

To install Güralp Discovery: 

1. Open the terminal 

2. Visit www.guralp.com/sw/download-discovery.shtml to download the appro-
priate installation script or use the command 

wget http://www.guralp.com/download/discovery/Discovery.run 

3. Make the downloaded file executable using the command 

chmod +x Discovery.run 

4. Run the script with the -h option to see the installer's help message: 

./Discovery.run -h 

Online installer for Guralp Systems Discovery application 

Usage: ./Discovery.run [parameters] 

Parameters: 

-h : this message 

-i : perform installation 

-o <directory> : output directory (default 

/opt/guralp/discovery) 

5. Execute the script, either accepting the default installation directory 

./Discovery.run -i 

or providing your own, alternative location 

./Discovery.run -i -o /usr/lib/discovery 

http://www.guralp.com/sw/download-discovery.shtml
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The script proceeds through the following installation stages: 

1. A confirmation prompt: 

Guralp Discovery will be installed in: 

/opt/guralp/discovery. [C]ontinue/[A]bort 

Type  to continue installation in listed directory, or  to abort and 
change directory using the -o execution parameter 

2. Downloading. The following message is printed: 

Downloading Discovery from Guralp Systems server 

[Downloading] 

This step downloads the discovery package from the Güralp server. It is around 
50 MiB in size so downloading may take a long time if you have a slow Internet 
connection. 

3. Next, the following message is printed: 

Creating installation directory: /opt/guralp/discovery [OK] 

This step creates the installation directory. If an error occurs at this stage, 
please make sure that the user running the installation script has permission 
to create the specified directory. 

4. The downloaded archive is now unpacked into the specified installation direc-
tory. The following message is printed: 

Unpacking Discovery to /opt/guralp/discovery [OK] 

5. The next step removes the downloaded file from the disk. 

Removing downloaded Discovery archive [OK] 

6. A this point, the installation is complete. The message 

Discovery is now installed in: 

/opt/guralp/discovery/discovery 

is displayed and the application is available in the specified directory. 

10.2  Installation in Windows 

To install Güralp Discovery on a Windows machine: 

1. Download the appropriate installer – 32-bit or 64-bit – from 

https://www.guralp.com/sw/download-discovery/ 

2. Double-click the downloaded file. You may be asked whether you wish to con-
tinue: answer yes. 

https://www.guralp.com/sw/download-discovery/
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3. The following screen asks where, in the Start Menu, you would like to place 
the Discovery short-cut. The default location is normally satisfactory but you 
can change it from here if you wish. 

 

Click , key  or key +  to continue. 

4. The next screen asks whether you would like to place an icon for Discovery on 
the desktop: 

 

Tick the check-box if you wish and then click , key  or key 

+  to continue. 

5. The installer then offers a last chance to change any of your decisions: 
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Click , key  or key +  if you are happy with your 

choices or click  (or key + ) if you wish to revisit any of 
them. 

6. Once you have clicked , the installation begins and a progress 
screen is displayed: 

 

Pressing  or keying  now will remove all of the installed files 
(except the installer itself) and reverse any changes made so far. 

7. Once installation is complete, the following screen is displayed: 
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Press , key  or key +  to close the installer and 
launch Discovery. 

 

10.3  Configuring Windows Firewall 

Windows Firewall can interfere with Discovery’s ability to send information to 
instruments and/or receive information from instruments over the network. If you 
use Windows Firewall, you should make special provision for allowing Discovery to 
communicate, as described in this section. 

1. Click in the “Ask me anything” search box at the bottom left of your Windows 
screen: 

 

Note: Discovery for Windows 64-bit requires Microsoft Visual C++ 2015.  
Discovery may ask to install it if it is not installed yet. 
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2. Type “allow an app” 

 

3. Select “Allow an app through Windows Firewall” from the search results. 

4. Windows will display the “Windows Firewall Allowed Applications” screen. 

This displays a list of applications in alphabetical order. Each application is 
provided with three check-boxes which indicate whether the application can 
communicate with networked devices in the “Domain” profile, the “Private” 
profile or the “Public” profile. (Profiles are also known as “network locations”.) 
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The “Domain” profile applies to networks where the host system can 
authenticate to a domain controller. The “Private” profile is a user-assigned 
profile and is used to designate private or home networks. The default profile 
is the “Public” profile, which is used to designate public networks such as Wi-
Fi hotspots at coffee shops, airports, and other locations. 

For a more complete discussion of this topic, please see 
http://www.tenforums.com/tutorials/6815-network-location-set-private-
public-windows-10-a.html or your Windows documentation. 

5. First click the  buttons to activate the interface. 

http://www.tenforums.com/tutorials/6815-network-location-set-private-public-windows-10-a.html
http://www.tenforums.com/tutorials/6815-network-location-set-private-public-windows-10-a.html
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6. Highlight the “discovery” line and then click the  button. The “Edit 
an app” window is shown: 

 

7. Click the  button. The “Choose network types” window is 
shown: 

 

8. After making appropriate changes, click  first in the “Choose net-
work types” window, then in the “Edit an app” window, then in the “Windows 
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Firewall Allowed Applications”. This closes the Windows Firewall “Allowed 
Applications” tool and saves the changes that you have made. 

10.4  Update 

If a PC running Güralp Discovery has an Internet connection, Discovery can check 
whether an update is available. To initiate this, click About from the Help menu or 

type +  followed by : 

 

A screen like the following is displayed: 
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The currently installed version is shown. If this is the most recent version 

available, the screen will say Up to date and the  button will be 
disabled, as shown above. If a newer version is available, the screen will look like 
this: 

 

If you wish to proceed with downloading the newer version, click the  
button. This does not commit to an immediate upgrade: it just downloads the 

installer. If you do not wish to download the installer, click  to close the 
“Discovery About” dialogue. 

If you clicked , you may see the following warning if the previous 
installer is still in your download folder: 

 

Simply click  or key  to continue: the download will start 
immediately. 
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While the download is in progress, the following indicator will be displayed: 

 

When the download is complete, the following screen is displayed: 

 

If you wish to complete the installation immediately, click . If you 

would rather defer the installation, click  and run the installer at a more 
convenient time. 

Once the upgrade is complete, start Discovery in the usual way. Windows, 
recognising that the program has changed, may ask you to specify how you wish 
Discovery to interact with the Windows Firewall. Because Discovery requires 
network communication in order to function, it is important that you understand 
the options available. 



Güralp Discovery - Software Manual  Appendix 1 - Güralp Discovery Installation 

MAN-DIS-0001 107  

 

The following screen is displayed: 

 

The screen provides three check-boxes which indicate whether Discovery can 
communicate with networked devices in the “Domain” profile, the “Private” profile 
or the “Public” profile. (Profiles are also known as “network locations”.) 

The “Domain” profile applies to networks where the host system can authenticate 
to a domain controller. The “Private” profile is a user-assigned profile and is used to 
designate private or home networks. The default profile is the “Public” profile, 
which is used to designate public networks such as Wi-Fi hotspots at coffee shops, 
airports, and other locations. 

For a more complete discussion of this topic, please see 
www.tenforums.com/tutorials/6815-network-location-set-private-public-
windows-10-a.html or your Windows documentation. 

http://www.tenforums.com/tutorials/6815-network-location-set-private-public-windows-10-a.html
http://www.tenforums.com/tutorials/6815-network-location-set-private-public-windows-10-a.html
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11  Appendix 2 – I.P. Address Configuration 
on PC or Laptop 

With APIPA (Automatic Private I.P. Addressing), a laptop or PC can automatically 
configure itself with an I.P. address in the range 169.254.0.1 to 169.254.255.254. 
The default subnet mask is 255.255.0.0. 

Connect you Güralp device to the laptop or PC using the blue Ethernet cable and 
power it up. 

11.1  On Linux 

On your Linux computer, open the terminal and type the command 

sudo bash 

Key  and provide the appropriate password. Then, enter the command 

ifconfig 

to identify the Ethernet network interface to which your device is connected. Once 
you have identified the correct interface, connect the device, power it up and enter the 
commands 

ifconfig wlp2s0 down 

ifconfig wlp2s0 up 

replacing wlp2s0 with the name of the appropriate interface on your PC. 

Enter the command ifconfig again to verify that the IPv4 address of the Ethernet 
adapter is now included in the network 169.254.0.0/16 - i.e. the address begins 
169.154.… 

 
In the example above, the interface has been allocated address 169.254.139.29, 
which is in the correct network. 
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11.2  On Windows 

On a Windows computer, key +  to open the "Run" dialogue, enter ncpa.cpl 

and key . 

Right-click on the network adapter which is connected to the device and select 
“Disable” from the context menu. Right-click on the same adapter again and select 
“Enable”. Close the network settings window. 

Key +  and type cmd., then . This opens a command window. Type the 
command ipconfig and verify that the IPv4 address of the Ethernet adapter is 
included in network 169.254.*.*. 

 

In the example above, the interface has been allocated address 169.254.139.29, 
which is in the correct network. 
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12  Appendix 3 - Operation with 3rd Party 
Products 

Discovery and GDC supports systems that source data using SeedLink protocol. This 
is a well-defined ‘Industry Standard’ protocol that is supported by many 
manufacturers.  

The streaming protocols are standard yet typically the mechanism of discovering and 
finding the IP address of a device is manufacturer specific. 

In order to allow Discovery and GDC to access data from 3rd party devices, Güralp has 
added a mechanism to add an entry for that device in the Devices list in Discovery. 

Once we have made the Discovery aware of the existence of the device, we can 
perform a number of operations on the device – such as viewing the WEB page or 
streaming data. 

There are two mechanisms of adding a ‘fixed’ device to the device list: 

1. For Local devices (ordinarily found by Scan Local) we can Edit/Add Device. 

This should largely be used to test a connection. Using this to add a Güralp 
product is NOT recommended as the normal automated discovery 
mechanism should work. If not, other problems will likely follow! 

These manually ‘added’ devices are not saved as their use is only 
transitory. 

2. For Remote devices an entry can be added to the Cloud registry. This is a 
permanent addition as the details are saved on the registry server.  They 
can also be individually deleted. 

This operation is performed from the Güralp “Test Facility” application. 
This is available from the Start menu/Guralp Systems on Windows 
systems. On Linux the executable ‘Thing’ should be run.  

 

Figure 78 Test Utility 

Use the Add button to send a packet to the Registry (IP Address specified) thus 
registering the present of such an instrument.   
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Assuming that the device is a SeedLink server, specifying Station and Network code 
and the devices IP Address, will give Discovery sufficient information for it to request 
SeedLink data or instruct a GDC to request SeedLink data. 

Leaving the Station and Network blank will cause Discovery to probe the system for a 
list of Stations when a GDC connection is requested. 

 



Güralp Discovery - Software Manual  Revision History 

MAN-DIS-0001 112  

 

13  Revision History 

A 2022-03-11 Initial release 

   

   

   
 


